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1. Software Overview
This Technical Memo describes the version upgrading of the application software of MFS-2000

to V3.20. The Editing Control Software BZS-8050 (Plug In Editor) that is included in the above
application software is also upgraded to V3.00 at the same time.

All of the software that are described in this Technical Memo should be upgraded to the new
version in order to realize the new functions and bug corrections as described below, including
version upgrading of MFS-2000 FPGA.

1.1 New Functions
The following new functions are added from version V3.00 of the BZS-8050 over V2.01.

(1) Field editing (IN point, OUT point and transition start point can be set in the second field.)

(2) Rip sync adjustment by the SYNC PLAY and FRAME BUMP (PLAY+/-).

(3) Background recording (Creation and modification of editing can be performed during

recording.)

(4) Programmable function key (A series of key operations can be programmed by the actual

operations.)

(5) Superimpose (Editing information can be displayed on the edit preview bus.)

(6) Master/Sub setting

(7) Introduction of the concept of project (Project in units of program or editor can be set, and
backed up.)

(8) Multi EDL (Multiple numbers of EDL can be stored in a project, and the EDL for each

scene can be merged.)

(9) EDL SAVE/LOAD of the CMX format

(10) Setting the VTR constants can be made from the BZS-8050 side (Setting the user table

and copy/recall of constants are possible.)

(11) Initial panel (The switcher setup status when editing is started can be saved in EDL.)
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(12) AUTO EFFECT DATA (The effect register data of switcher can be saved in EDL.)
1.2 Specification Change

The following specification changes are implemented in version V3.00 of the BZS-8050 over
V2.01.

(1) When an already-registered edit is going to be modified and saved, whether it is registered
as a new edit in accordance with the QUICK EDIT MODE setting, or it is modified and
registered can be selected by using dialog displayed.

(2) When the KF, FM, AUX or COLOR is specified as an editing source, the IN point can be set
automatically.

(3) Visibility of red and yellow characters is improved. At the same time the display color of
“ASSEMBLE” and “1ST EDIT” is changed to red.

(4) When the GPI setup menu is opened, event of the port that is selected last is displayed.

(5) Extension of the file that in which PRINTABLE is selected and saved by the SAVE EDL is
changed to “TXT”.

(6) In the case when the RIPPLE processing is not necessary, the display “NO RIPPLE” will
appear even when the RIPPLE MODE is OFF.

(7) Movement of the cursor when the Page Up/Down is operated by the scroll display or by
the NOTE input is changed.

1.3 Restrictions
BZS-8050 V3.00 has the following restrictions.

(1) SETUP > F9: When the SW CTRL and MX CTR are initialized by the DEFAULT setup,
only the display is initialized. In order to reflect result of the initialization to actual
operations, re-start the panel.

When using an effect (key frame) of a switcher, pay attention to the followings

(2) The regions that can be controlled by the MFS-2000 are only M/E (M/E1), P/P and MISC
(USER1). At the same time, it cannot control the DME eftect.

(3) When two types of key frames are mixed whereas DME has been set to one type of key
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frame while DME has not been set to the other type, there can be a case that the effect can
lag or lead in the midst of the effect. To prevent occurrence of this trouble, set DME from

the very first key frame.

(4) If an effect in which animation of frame memory data has been created is used, execution of
the effect delays after the set editing point by one frame. To prevent occurrence of this

trouble, advance the editing point by one frame beforehand.

(5) When using the effect that is used to create animation of frame memory, do not set the

initial speed.

(6) When the AUTO SCAN is in progress while the system is connected to a system manager,
there can be cases that several 10 seconds are required to transfer to register data of the
switcher. (The TRANSFERRING FILE is displayed.)

(7) The register numbers of the switcher panel remain unchanged even when the register data
of a switcher is transferred.
In order to operate the register of the number being displayed, repeat the RECALL

operation again.

(8) When register data of a switcher is transferred, the register name will not be inherited.

1.4 Bugs Corrected
1.4.1 Switcher Bugs Corrected
MFS-2000 V3.20 corrects the following bugs that are confirmed in the previous version.

(1)  When the DEFAULT RECALL is executed for the M/E and P/P, the default value is not

reflected to some parameters.

(2) There can be cases that video signal of frame memory is shifted by one horizontal line

when the re-position function of frame memory is used.

(3) When Effect-Dissolve or Timeline of Snap Shot is used, there are cases that direction of

the parameter interpolation of the Effect pattern is reversed.

(4) When the signal format is HD, spot noise appears sometimes in the bottom right of a

screen.

(5) When the Msk/Brd Proc is set from Border to Mask, there are cases that edge of the mask
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becomes black.

1.4.2 Panel/Menu Bugs Corrected
MFS-2000 V3.,Q0 corrects the following bugs that are confirmed in the previous version.

(1)

2)

When any button to which Macro attachment is set, and when the same button is pressed
again while the Macro execution is in progress, the Macro execution can be aborted.
However, if the Macro attachment is set in the Macro only mode, the Macro execution

cannot be aborted, but the original function of the button is executed.

The PAUSE setting time is not displayed normally during editing of Macro.

1.4.3 BZS-8050 Bugs Corrected
The following bugs of BZS-8050 V2.01 are corrected in BZS-8050 V3.00.

(1)

2

3)

“4)

)

(6)

There can be cases that Mark-IN/Out of KF source fails when the Active Line setting is
1080PsF.

MODIFY is executed even when the EDIT MODE is not specified yet when the menus
are selected from MODIFY > EDIT.

When RECORDER s set by selecting the menus either SWER CTRL > MONITORING
or MIXER CONTROL > MONITORING, the EDIT PRESET is issued to the equipment
other than RECORDER during preview.

When the Manual Override is executed in the DMC editing, the passing speed at the OUT
point is not reflected on the new edit.

When the edit number reaches the upper limit and “N0000” is displayed, the Open-End

editing becomes impossible.

When an edit that is accompanied by learn data created by BVE-9100 is loaded, there can
be cases that the edit becomes an illegal edit.

1.5 Related Technical Memos
= SWEMO04-047 “MVS-8000 System Application Software Is Upgraded to V4.10”

DCU (MKS-8700/2700) V4.10 related Technical Memos
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1. Software Overview
This Technical Memo describes the version upgrading of the application software of MFS-2000
to V3.30 (V3.31 for SWR) «Rev.1. The Editing Control Software BZS-8050 (Plug In Editor)
that is included in the above application software is also upgraded to V4.00 at the same time.
All of the software that are described in this Technical Memo should be upgraded to the new
versions in order to realize the new functions as described below.

1.1. New Functions
1.1.1. New functions of switcher

(1) The following video format is newly supported from this version.
The video format of 720P/50 is supported.
The 720P mode is valid only when the Multi Format Option is installed.

(2) The following Effect related functions are added.
The Effects can be executed by using the transition dedicated to the key.
The Auto Transition can be executed by using the transition dedicated to the keys of the KEY'1
ON and KEY2 ON buttons of the Transition Operation Block. (In MKS-2010 only)
The Effect Patterns can be set by entering the pattern number in the effect pattern select pop-up
window of GUIL.
The new function (Crop Link) is added. The Crop Link is the function to automatically adjust
for the best position in accordance with the amount of the set crop when using crop in the
Squeeze Effect (pattern No. 1025 to 1028).
A mode that has no dead zone is added to the M/E Effect Crop Transition.

(3) Pattern Limit function is added.
Pattern Limit can be used when Effect (Wipe) is used as the transition type.
The Pattern Limit function cannot be sued in the transition dedicated to key.

(4) Trim function is added to the ten-key window.
The Trim function is added to the ten-key window of GUI. Use this function by entering the
amount of different and pressing the [Trim] button when inputting parameter.

(5) The Save and Call functions of the frame memory file using external hard disk are added.
When the IEEE 1394 external hard disk is connected to the IEEE 1394 port of the switcher
main unit, saving the still pictures on the frame memory in the hard disk or calling the saved
still pictures from the external hard disk became possible.

(6) GPI Output Action is added.
The Error Make / Break is added as a choice of the GPI Output Action of the switcher and DCU.

(7) USB related function is added.
The initializing function of the memory stick or of the memory device connected to the USB
terminal is added.
The software installation by using the USB memory became possible.

(8) Source signal name editing function is added.
The function to modify the source signal name that is displayed on the operation panel of the
AUX bus remote panel MKS-8082, and that of the BZS-8050 (Plug-In-Editor) is added.
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(9) Editor I/F control mode is added.
The control mode that enables the machine operations to be equivalent to those of the DVS-
7000 when the ALL STOP command is received from an editor is added.
This setup is used by the following menu. To move the Setup Menu, enter the page number
9711 directly and execute it.
Page 9711: Setup/Diag>Maintenance>Editor I/F

The setup mode details and the control details when receiving the ALL STOP command are
described below.

< MVS-8000 mode
The Background state is returned to the original state before the Transition is executed, and
all keys are set to OFF. (This is the control that has been made conventionally.)

<> DVS-7000 mode
Only the keys that are specified by the ALL STOP command are turned OFF. However, the
above operation is not 100% equivalent to that of the DVS-7000 because the Background and
keys that are selected by the Next Transition Operation Block are selected as the target of the
control in addition to the keys that are specified by the ALL STOP command while the
transition operation is in progress.
If a transition in which P/P DSK is included in the Next Transition is executed by an editor,
all buttons of the P/P Transition Type on the MFS panel will be turned OFF. In such a case,
press the WIPE or MIX button of the P/P Transition Type manually before executing the
Transition operation. Then, set the transition type again and then use this function.

(10) Disk Recorder (VDCP) control setting items are added.
The following setting items are added.

< Filename Mode setting
Fixed 8 Character / Variable Length can be selected.
< Timecode Sense setting
SOM Based / Zero Based can be selected.
< Still Delay setting
The response time from issuing the Still command until stop can be set.
< Continue Delay setting
The response time from issuing the Continue command until stop can be set.

(11) Short-cut button to the Timeline menu is added.
Shortcut button to move back and forth between the Page 8000 Timeline menu and the Page
8100 Path menu is added.

1.1.2. New Functions That Are Added from BZS-8050 V4.00
The following new functions are added from version V4.00 of the BZS-8050 over V3.00.

(1) Sync Jog - - - The Key Frame (Effect) of the DME or that of the switcher can be
synchronized automatically to the JOG operation of VTR.

(2) DMC event creation - - - The speed event of the Key Frame (Effect) of VTR and that of
DME and switcher can be created. Creation of freeze event for VTR is
possible, and recall of register for Effect is also possible.
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List Management function is reinforced - - - The following functions are added t the List
Management.
* B-MODE and C-MODE are added as the conditions for sorting. (SORT)
+ Inputting of the EDL that is output from BVE-9000 became possible. Output to BVE-9000
is also possible.
(LOAD EDL, SAVE EDL)
+ Reel summary indication (REEL SUM)
+ Gap detection (GAP)
+ Deletion of Gap or Overlap (APPEND)
* Quick trace (Q-TRACE)
+ Advanced cleanup (ADV CLNUP)

Editing of PF key - - - The programmable function key can be set, added, modified, deleted,
or number of loops can be specified without executing the actual editing
operation.

Control of disk recorder - - - The "DDR SD9P" and "DDR VDCP" that have been set as the
device type by the switcher can be controlled. (“DDR VDCP” can be
controlled as a player only. Loading of file should be done by using the
switcher menu.)

Switcher preview - - - Previews can be executed to check the set effects without actually
operating VTR, disk recorder and audio mixer.

Keyboard assign - - - Assignment of functions to keys can be freely set.

Monitoring Mode is added. - - - "RECORDER?2" is added to switcher and audio mixer.
"PVW (PARA)" is added to audio mixer.

Screen layout setting - - - Display position of the recorder/source on screen can be changed.
At the same time, the background color of screen can be freely set.

Timecode source setting - - - The timecode source that is conventionally set by the
switcher can now be set by the editor.

Color framing editing - - - The color framing phase of recorder machine is detected and is
controlled so that the color framing phase is matched during recording.
(This function is available in NTSC machine only. The color framing phase
of player machine cannot be controller.)

1.2. Specification Change

1.2.1. Switcher related specification changes

No

change.

1.2.2. Specification changes of BZS-8050 after V4.00

The following specification changes are implemented in version V4.00 of the BZS-8050 over
V3.00.

(1) Filename entry when PRINTABLE is selected by SAVE EDL is enlarged from 6 characters

or less to 8 characters or less.
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(2) Assign screen of Initialize is changed.
+ The DCU port name that is set by the switcher is displayed.

+ The device name will be displayed in grey when the DCU port is not set to “Editor Enbl”
by switcher.

(3)The VTR CTRL screen of setup is changed.
+ The DCU port name that is set by the switcher is displayed.

+* The device type that is set by the switcher is displayed. Device type is displayed in red
except for VTR.

(4) “EDL CLEAR” of Initialize Menu is moved to F1 of the function menu 2™ page.

1.3. Restrictions

1.3.1. Restriction on the IEEE 1394 external hard disk
(1) Hard disk models with which operations have already been verified:

Use the following models of Maxtor as the external hard disk drive of MFS-2000. Do not use
the hard disk other than the following models.

< Hard disk models of Maxtor OneTouch III Firewire 400 / USB 2.0 supported
Model numbers
F30A200 (200GB)
F30G300 (300GB)
T30A200 (200GB)
T30G300 (300GB)

306320220683 - qRev.1 T30G320 is deleted from the recommended models.

(2) Initialization step
The purchased external hard disk drive needs to be initialized before using.
When the menus [Page 4800: Frame Memory > External HDD > Format] and execute
[Format] by following the steps described below.

+ Connect the hard disk drive to the switcher and turn the power ON.

+ The LED lamp on the front of the hard disk drive flashes for several seconds. Do not perform
any operation while the LED lamp is flashing.

+ Select the menus in this order: [Page 4800: Frame Memory > External HDD > Format]. Press
the [Refresh Status] button. An error message may be displayed sometime but you can
ignore it and press the [OK] button.

+ Press the [Format] button to start initialization of the hard disk drive.

Initialization will complete in several minutes.

(3) Backup/Restore operation
When the menus [Page 4800: Frame Memory > External HDD > Backup/Restore] is selected
to execute saving or reading of frame memory image, the machine looks as if it stops for
several minutes that are required for preparation of the save/read operations if a large amount
of frame memory images are going to be handled.

1.3.2. Other Restrictions
(1) P/P Wipe patterns select operation
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If any pattern number other than the range of 1 to 24, 901 and 902 that can be used as P/P
Wipe as the P/P Wipe pattern is input by the Flexi Pad operation block, the P/P Wipe transition
cannot be executed normally.

In such a case, re-set a usable pattern number as the P/P Wipe pattern.

(2) Operation of the M/E effect pattern 1031
The H-position adjustment value is in the range of £75.00 at both ends of right-most end and
the left-most end of the M/E effect pattern when running the system in the 16:9 aspect mode.

1.3.3. Restrictions on BZS-8050 V4.00

When using an effect (key frame) of a switcher, pay attention to the followings

(1) The regions that can be controlled by the MFS-2000 are only M/E (M/E1) and P/P and MISC
(USER1). At the same time, it cannot control the DME effect.

(2) When two types of key frames are mixed whereas DME has been set to one type of key frame
while DME has not been set to the other type, there can be a case that the effect can lag or
lead in the midst of the effect. To prevent occurrence of this trouble, set DME from the very
first key frame.

(3) If an effect in which animation of frame memory data has been created is used, execution of
the effect delays after the set editing point by one frame. To prevent occurrence of this
trouble, advance the editing point by one frame beforehand.

(4) When using the effect that is used to create animation of frame memory, do not set the initial
speed.

(5) When the AUTO SCAN is in progress while the system is connected to a system manager,
there can be cases that several 10 seconds are required to transfer to register data of the
switcher. (The TRANSFERRING FILE is displayed.)

(6) The register numbers of the switcher panel remain unchanged even when the register data of
a switcher is transferred.
In order to operate the register of the number being displayed, repeat the RECALL operation
again.

(7) When register data of a switcher is transferred, the register name will not be inherited.

1.4. Bugs Corrected

1.4.1. Switcher Bugs Corrected
(1) When a register file is loaded from an Editor, the register name is not reflected normally.

(2) When a recalled frame memory image is deleted, or an image having the same name is loaded,
the frame memory output and the GUI frame memory state are not displayed normally.

(3) Status of the Shadow Soft is not displayed normally on GUI during the Snapshot recall.
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1.4.2. DME Bugs Corrected
(1) When the 2 ch PinP pattern is generated in the user-programmable DME, the parallel tally
and the panel button tally do not match,

(2) When the key frame fader is operated during timeline editing in the state in which the key
frame event does not exist, the M/E effect works sometimes.

(3) When Crop of the M/E effect is operated at Release Transition Last 5%, the Crop and the
Border Release operation do not interlock.

1.4.3. Panel/Menu Bugs Corrected
(1) When an USB memory is used, the GUI operations become slow sometimes.

(2) When a large capacity USB memory is used, the software that is desired to be installed is
not displayed on the Manual Install menu sometimes.

(3) Parameter of the Key Edge button is not displayed correctly sometimes.

(4) Even though the machine is operating normally, the GUI recovery operation occurs once
every half year.

(5) When a Snapshot is called with Bus Toggle OFF, the fader LEDs light in the order opposite
to the direction of operation.

(6) If Action has been set at the DCU GPI Output before executing DCU Output Config, GPI
does not work normally until the SCU is restarted.

(7) If top of a file is other than 00:00:00 in the control of DDR VDCP, Cue up could not be
executed normally.

(8) The Sea Change DDR does not work normally when it is controlled by DDR VDCP.

1.4.4. BZS-8050 Bugs Corrected
The following bugs of BZS-8050 V3.00 are corrected in BZS-8050 V4.00.

(1) If an Edit in which GPI has been set is saved and loaded by the BVE-9100 format, the Edit
could not be read normally sometimes.

(2) When the SW CTRL or the MX CTRL is initialized by SETUP > F9: DEFAULT, the setup
display is initialized but the actual operation is not initialized.

(3) If Project name of EDL name contains the symbols such as parenthesis, single quotation or
apostrophe, the EDL cannot be recognized.

(4) The field mark that indicates the VITC signal with super-impose cannot be displayed when
the signal format is 5761/50.
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Overview of Software
This software is the MFS-2000 application software that is upgraded to V3.40.
The Editing Control Software BZS-8050 (Plug In Editor) included in this software is upgraded to
V5.01.

To achieve the new added functions and bug fixes mentioned below, all of the software described
in this Technical Memo must be upgraded.

New Function
1.1.1 New function related to the switcher

(1) Addition of VITC setting in the external equipment control ... The VITC can be set to the
time code source (reference signal for judging the tape position).
Set the VITC in the [Menu 9502: Setup/Diag > Device > Port Setting] menu.

1.1.2 New function of BZS-8050 V5.01
In the BZS-8050 V5.01, the following functions are added to V4.00.

(1) JOG DIAL RESPONSE ... The tape transporting amount with respect to the dial rotational
angle in the jog mode can be set.

SETUP > F1: KEYBOARD > 4. JOG DIAL RESPONSE (LOW*, MID, HIGH)

(2) DIAL DIRECT CONTROL ... The selected device can be controlled in the mode previously
used by turning search dial without pressing the JOG, SHTL and VAR keys.
To make this function valid, setting in the setup menu is necessary.
SETUP > F1: KEYBOARD > 5. DIAL DIRECT CONTROL (ON, OFF*)

(3) SELECT R1 AFTER ... When setting the multi-recorder, the condition to select R1 when R
key is pressed can be set.
SETUP > F1: KEYBOARD > 6. SELECT R1 AFTER (SRC ONLY*, ANY KEY)
“SRC ONLY™: R1 is selected when the source selection key is pressed after the R key is
pressed previously.

“ANY KEY”: R1 is selected when any key is pressed after the R key is pressed previously.

(4) DME CONTROL ... The selection to control the DME can be set.
SETUP > F7: DME CTRL (DISABLE, ENABLE*)

In case of MKS-8050 keyboard, this setting can be opened by pressing the SWER CTRL key
while pressing the CTRL key.
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(5) VTR RELEASE MODE ... Even if the device of source is operated at the device side after
passing the IN point and the status becomes unexpected, the execution can be continued
without being stopped by the error.

In this case, the operated device is excluded from the target of automatic execution and can
be controlled from the keyboard.
To make this function valid, setting in the initialization menu is necessary.

INIT > F2: EXECUTION > 8. VTR RELEASE MODE (ON, OFF*)

(6) DME/KF AUTO TIME TRACK ... When registering a new edit page in the EDL, the time
track can be set to the DME and KF source in the same manner as VTR.

To make this function valid, setting in the initialization menu is necessary.
INIT > F3: EDL > 11. DME/KF AUTO TIME TRACK (ON, OFF*)

(7) SOURCE DATA LAYOUT ...“ST-PO-TC”, “ST-TC-PO”, and "PO-TC-ST” have been
added to the selection item.
INIT page 2 > F2: MENU DISP > 1. SOURCE DATA LAYOUT

(8) Audio Monitor Control ... The monitor output of audio mixer of each channel can be
independently turned off or on. The ON/OFF state is displayed on the edit menu.
(The audio mixer, that supports commands in the ESAMII protocol, must be used.)
To use this function, the function should be assigned to the key in the key board assignment.
INIT page 2 > F3: ASIGN KEY > “MONITOR A1-A8” of F7: SOURCEI

(9) Specifying the region when saving the system set data ... When saving the setup data and
the initialization data, an arbitrary region can be selected. When loading, only the saved
region is read in.

SETUP / INIT > F8: HNDL FILE > F3: SAVE(HDD) / F4: SAVE(USB)

(10) Support to VITC ... The VITC has been added to the selection item of time code source.
When LTC and VITC are not matched, if VITC is selected, cueing or automatic execution

may not be correctly performed. Do not select VITC for recorder.
AUX > F2: TC SOURCE

(11) Temporary Cross-point Setting ... By changing temporarily the cross-points of recorder and
source, they can be registered in the EDL.
AUX > F7: TEMP XPT
The temporary cross-point of registered edit can be changed in the list management.
LIST MNG > F4: MODIFY > F9: X-POINT
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(12) Frame Control Mode Setting ... When a tape is not inserted in the VTR, the edit point can be
entered by specifying the drop frame mode or non-drop frame mode. (In case of frame rate of
59.94/29.97, 60/30)

AUX > F8: FRM CTRL
The frame control mode of registered edit can be changed in the list management.
LIST MNG > F4: MODIFY > F7: FrameMODE

(13) Moving or copying an EDL ... An EDL can be moved or copied to other project.
EDL > F4: MOVE / F5: COPY

(14) Exporting/Importing an EDL ... The EDL including all of edit data can be exported to or
imported from an external memory device.
EDL > F8: IMPORT / F9: EXPORT

(15) Manual Pre-read ... When setting a pre-read edit, in addition to the conventional auto
pre-read (A recorder is selected for source.), the ON /OFF or CONTINUE (New page only,
set it to ON and succeed it to the next edit.) of pre-read edit can be manually set.

This function is assigned to CTRL+AUDIO keys.

(16) Edit Mode Override ... During recording the insert edit, the edit mode can be manually
changed.

(17) Manual Recording (MAN-R) ... While running the recorder, recording or interruption can be

performed at any timing.

(18) Video Process Control of VTR ... The video process (video control) of VTR can be adjusted
and its set state can be registered in the EDL.
DMC EVENT > F1: V PROCESS

(19) Switcher Event ... In addition to the conventional initial panel, an event of transition start
and the snapshot register recall can be created.
SWER EVENT > F2: TRANS / F3: SNAPSHOT
In case of snapshot register recall event, the selection of registering the register data in the
EDL or registering the register No. only in the EDL can be set in the setup menu.
SETUP > F3: SW CTRL > 7. SNAPSHOT DATA TRANSFER (ON, OFF*)

(20) Auto Video Process Data ... The video process data set to the input of switcher can be
automatically registered in the EDL. To make this function valid, setting in the setup menu

1S necessary.
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SETUP > F3: SW CTRL > 9. AUTO VIDEO PROCESS DATA (ON, OFF*)

(21) Switcher’s Color Correct Control ...The use of color corrector is used for input signal of
switcher corresponding to the reel can be set. When the color corrector is used, the color
corrector data is registered in the EDL.

REEL > F8: CCR1/ F9:CCR2

(22) Mixer Event ... An event of transition start and the register recall can be created. In the
register recall, only the register No. is registered in the EDL and the register data is not
registered.

MIXER EVENT > F2: TRANS / F3: REG RECAL

(23) Recall Segment ... A part of saved edit data setting can be copied to other edit.
To use this function, the function should be assigned to the key, using the keyboard
assignment.
INIT page 2 > F3: ASIGN KEY > “RECALL SEG” of F6: EDL

(24) Fly Edit ... An edit can be created by selecting the source one by one during recording or
previewing. And the created edit can be registered in the EDL.
LIVE EDIT > F1: FLY (PVW) / F2: FLY (REC)

(25) Butt Edit ... Recording can be started by making the present position of a device as an
in-point without setting IN point.
To make this valid, setting in the initialization menu is necessary.
INIT > F2: EXECUTION > 5. BUTT EDIT (ON, OFF*)

(26) Non-stop Edit ... When executing without re-synchronization is possible, recording can be
done at once without stopping at each edit.
To make this function valid, setting in the initialization menu is necessary.
INIT > F2: EXECUTION > 6. NONSTOP EXECUTE (ON, OFF*)

(27) Log at the auto assembly ... In executing the auto-assembly, when not accurately

synchronized or an error occurs, it is saved in the log and can be confirmed after executed.

(28) Scroll Search ... By specifying the condition, the edit on the scroll display can be searched.
The search on the entirely scrolled menu is also available. To call the searched edit, press
the F8: RCL SCRL.

RECALL > F9: HALF SCRL/F10: FULL SCRL
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Specification Change
1.2.1 Specification Change of Switcher Related

(1) When using the BZS-8050, the luminance of superimposition is reduced to about 80% so
that the visibility is enhanced.

1.2.2. Specification Change of BZS-8050 V5.01
In the BZS-8050 V5.01, the following specification changes have been added to V4.00.

(1) After displaying the project list menu by pressing the PROJ key from the edit menu or EDL
list menu or after displaying the EDL list menu by pressing the EDL key from the edit menu,
if the valid operation is not performed in the display menu, the menu return to the previous

menu by pressing the RET key.

(2) On the EDL list menu or the project list menu, characters of the EDL edited last and its
project are highlighted yellow.

(3) When assemble-editing or the 1% edit is selected, characters of "ASSEMBLE" and "1ST
EDIT” are highlighted red.

(4) When the synchronization is set to “ACCURATE” (In case of DDR, more than
PRL&PLAY) and the time code source is set to “CTL”, the ID on the display area of

recorder/source data blinks.

(5) The cursors “>” and “<”, which do not move with the arrow key, blink.
The cursor, that moves with the arrow key, has been changed to “»”.

(6) The symbol displayed at the IN point time tracked has been changed from “T” to “.” and
blinks.

(7) When setting the A/B roll edit to the open end, by pressing consecutively the OPEND key
twice the OUT point of FROM source can be cleared.

(8) When open-end editing the CUT/MAN, the display position of GPI marker located behind
the IN point has been changed.

(9) The split setting of IN point and OUT point can be simultaneously released.
SPLIT > F10: ALL OFF

(10) When the pre-read edit is set, the recorder ID on the edit data display area has been changed
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from inversion to blinking.

(11) When recording the pre-read edit, if the monitoring setting is the preview bus system [PVW
BUS, PVW (MIX), PVW(PARA)], the signal of recorder and the signal to be recorded can

be switched as well as at preview.

(12) After entering the event time of GPI, the cursor does not move to the next event.

When the REF POINT is already set, even if the scrap pad is empty, an error does not occur.

(13) The SAVE PORT and RCL PORT functions of GPI have been changed and CLR PORT has
been changed.
The names of SAVE PORT and RCL PORT have been changed to COPY PORT and PASTE
PRT respectively. The location of CLR ALL has been changed.

SAVE PORT: It memorizes the setting of selected port. It can memorize the setting of each
port independently.
RCL PORT: It calls the setting of identical port which is memorized by SAVE-operating to
the selected port.
CLR PORT: It clears all of events of selected port.
Along with these changes, the function menu becomes as follows.
Page 1 F6: GPI CTRL > F7: CLR ALL (Moved), F8: CLR PORT (New)
F7: COPY PORT (Name change)
F8: PASTE PRT (Name change)
F10: -- 1 -- (Page selection of menu)
Page 2 F7: SAVE PORT (New)
F8: RCL PORT (New)

F10: -- 2 -- (Page selection of menu)

(14) Even if the IN point of recorder is not set, the player preview and switcher preview can be
executed.
When the IN point of recorder is set, the recorder preview can be executed.

Unless the edit is accomplished, the edit graph is not displayed as usual.

(15) When recording, if any one unit is inhibited to record, recording is not executed, displaying
the "REC INHIBIT" message.

(16) When displaying the recorded edit on the scroll display, the font of edit No. has been
changed so that the visibility is enhanced.
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(17) When calling the edit by specifying the time code, the entered time code is left on the scratch
pad.

(18) The function key to jump to the initialization menu has been added to the setup menu.
SETUP > F10: — INIT

(19) The specification of keyboard assignment has been changed as follows.
* The shortcut directly selecting the source contained in the DME, KF, FM, AUX, and
COLOR and the shortcut selecting several sources have been added.
INIT page 2 > F3: ASIGN KEY > F7: SOURCEI / F§8: SOURCE2
* Only when the INIT function is assigned to the key other than the INIT key, other function
can be assigned or un-assigned to the INIT key.
Caution: Remember the key to which the INIT function is assigned.
* In case of MKS-8050, other function can be assigned or un-assigned to the [PG UP], [PG
DN] and [ENTER] keys of 10 key block.
Accordingly, after the function assignment is fixed, the [ENTER] key of 10 key block

cannot be used.

(20) The constant display on the recorder/source display area can be set to all of the sources.
AUX > F4: SRC DISP

(21) When registering the edit set to the DME or KF source, it can be registered in the EDL by
automatically acquiring the effect register number.
However, the conventional setting of DMC EVENT > F1 EFFECT# is preferred to.
But, when AUTO EFFECT DATA = ON and the effect data is automatically acquired, the

register number is re-written to its effect register number.

(22) “Select several source and press the ENTER key” is the method that has been added to the
source selection of MAIN. In this case, the not-selected sources are exempted from the

additional sources.

(23) The state of frame control mode is displayed at the right hand side of recorder/source data
display area. (In case of frame rate 59.94/29.97, 60/30)
“d” The system is the drop frame mode and the device is the drop frame mode.
“D” The system is the non-drop frame mode and the device is the drop frame mode.
“n” The system is the non-drop frame mode and the device is the non-drop frame mode.

“N” The system is the drop frame mode and the device is the non-drop frame mode.

(24) In case that the monitoring setting of video and audio is separated into the preview bus
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system [PVW BUS, PVW(MIX), PVW(PARA)] and the recorder system [RECORDER,
RECORDER?2], only when the insert edit of signal alone set to the preview bus system is
previewed, the recorder’s signal is not delayed.

Caution: In this monitoring setting, when the insert edit of both video and audio is
previewed, the recorder’s signal may be delayed or the timing to switch the
video and audio may shift, depending on the recording format.

In principle, there is no alternative other than adjusting the monitoring systems
of video and audio.

(25) The condition to renew the date of EDL list menu has been changed so that the date is
changed when the change is added to the EDL.
But, when changing the name or comment, the date is not renewed.
The date of project list menu is renewed when deleting the EDL, adding the EDL (including
MOVE/COPY/IMPORT) or changing the EDL name.

When importing, a time spent in the export operation is displayed.

(26) When setting the DMC event to the TO source of A/B roll edit, the relative event time is set

in the relative value of recorder time code corresponding to the IN point of TC source.

(27) The present sort mode is displayed in the list display of project, EDL, directory and file.
Even if the power is turned off, the last sort mode is memorized.

Limited Item
1.3.1. Limited Item of IEEE 1394 External Hard Disk Drive
(1) Model on which the operation is confirmed

Use the Maxtor made model below for external hard disk drive of MFS-2000.

Do not use model other than these.

Maxtor OneTouch LI FireWire 400/USB 2.0 supported model
Model No.

F30A200 (200GB)

T30G300 (300GB)
Maxtor OneTouch I FireWire 800/400/USB 2.0 supported model
Model No.

F30W320 (320GB)

F30W500 (500GB)

(2) Initialization Procedure

Your purchased external hard disk drive needs to be initialized before use.
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Execute [Format] in the procedure below, using [Page 4800: Frame Memory > External HDD
> Format]

* Connect the hard disk drive to the switcher and turn on the power.

* The LED on the front of hard disk drive lights for a few seconds.
When the LED is blinking, do not operate.

* Perform [Page 4800: Frame Memory > External HDD > Format] to display and press the
[Refresh Status] button.
At this moment, the error message may appear. Ignore it and press the [OK] button.

* Press the [Format] button to execute the initialization of hard disk drive.
The initialization finishes in several minutes.

(2) Backup/Restore Operation
When executing the saving and read-in of frame memory image, using [Page 4800: Frame
Memory > External HDD > Backup/Restore], if a large amount of frame memory image is
targeted, the operation seems to be stopped for several minutes for preparing the
save/read-in.

1.3.2 Other Limited Item

(1) Operation of M/E Effect Pattern 1031
When operating the system in the 16:9 aspect mode, the H position adjustment value of M/E
effect pattern 1031 becomes +75.00 at the left and right ends.

1.3.3 Limited Item of BZS-8050 V5.01
Pay attention to the points below when operating the effect (key frame) of switcher.

(1) The region controllable with the MFS-2000 is M/E (M/E1), P/P, MISC (USER1) only.
The effect of DME cannot be controlled.

(2) If key-frames with DME and key-frames without DME exist, the effect may be delayed or
advanced depending on the execution range.

Therefore, set the DME to the key-frame, starting with the first key-frame.

(3) When the effect creating the animation of frame memory is used, the execution is delayed by
one frame with respect to the set edit point.

To avoid this, adjust the edit point beforehand.
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(4) When using the effect creating the animation of frame memory, do not set the initial speed.

(5) When the system manager is connected and the auto scan is being executed, it may take
several 10th seconds to transfer the register data of switcher (It is displayed as
TRANSFERRING FILE..).

(6) Even if the register data of switcher is transferred, the register number of switcher panel
remains unchanged.

When operating the register of displayed number, perform the recall operation again.

(7) When transferring the register data of switcher, the register name is not inherited.

When setting the video process data of VTR, pay attention to the following points.

(8) In case of HDW-500 series, even if HUE is set, the correct data is not received from VTR.
(After adjusted, the value changes when F7: REFRESH is pressed.

When HUE is set to other than UNITY, register by pressing the STORE key instead of
F2:LEARN.

(9) In case of HDW-500 series, the settable range -20 to 20 of HD SETUP is valid.
In case of SETUP, 0 to 20 is valid. When setting the out-of-range value of HD SETUP, the
value becomes the lower limit or the upper limit.
The level of actual output signal when registered matches with the level of output signal

when duplicated.

(10) In case of SRW-5000 series, the settable range -20 to 20 of HD SETUP is valid.
In case of SETUP, 0 to 20 is valid. When setting the out-of-range value of HD SETUP or
setting the positive out-of-range value of HD SETUP, the value becomes the lower limit or
the upper limit.
But, when setting the negative value to SETUP, the value may become the positive upper
limit.
The level of actual output signal when registered matches with the level of output signal

when duplicated.

(11) In case of HDW-2000 series, even if HD SETUP is set, the correct data can not be received
from VTR HD PR and it is affected by the set value of HD PR. (After adjusted, the value
changes when F7:REFRESH is pressed.).

When HD PR or HD SETUP is set to other than UNITY, register the data by pressing the
STORE key instead of F2:LEARN.
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Bug Fix
1.4.1 Bug Fix of Switcher

(1) When executing "Effect Recall" at SWR GPI Input, it may not be recalled.

(2) When recalling the Frame Memory, the still picture becomes bluish.

(3) In the Frame Memory Reposition V of 720p/59.94, a picture of green/pink may enter in the

lowermost line.

(4) When executing the Frame Memory Create KF, if Animation RUN is performed, the output

picture may blink.

(5) In the Frame Memory, when Field Freeze is performed in the state of Box Mask, the picture
may blink.

(6) When the Fader Curve is set to the Adv Tally Mode, the operation using the Fader cannot be
properly performed.

(7) When continuously operated without re-start (RESET) for about 50 days, the

communication of Data-LAN does not properly function.

1.4.2 Bug Fix of DME
(1) Even if the border width is set to “0(zero)”, the border remains.

(2) When using the slide pattern, the border leaks in the uppermost and lowermost lines.

(3) When using the Beveled Edge in the SD 4:3 mode, the quality of a picture having slant lines

1S poor.

(4) When continuously operated without re-start (RESET) for about 50 days, the
communication of Control-LAN/Data-LAN does not properly function.

1.4.3 Bug Fix of Panel /Menu
(1) When performing the CCR LEARN after executing the CCR UNITY, the LEARN of data
before UNITY is performed.

(2) “Timeline Recall ?" cannot be set in the DCU GPI Input.
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(3) When entered in the STORE MODE, the register may not be recalled.

(4) The file, which performs MacroAttach to FTB, cannot be correctly loaded.

(5) When continuously operated without re-start (RESET) for about 50 days, the

communication of Control-LAN does not properly function.

1.4.4 Bug Fix of BZS-8050
In the BZS-8050 V5.01, the following bugs existed in V4.00 have been fixed.

(1) When executing the auto track, the condition “The present mode is not included.” is not

considered.

(2) When the monitoring of video or audio is set to “RECORDER?”, if the recorder with source

selected 1s changed to the player, it remains EE.

(3) When the monitoring of either video or audio is set to the recorder system [RECORDER,
RECORDER?2], if the one set to the recorder system is used as the split base, the following
bugs occur.

* When previewing the advance edit of IN point, switching the signal of split base is
performed early by the amount of split.
* When previewing the insert edit of non-split base one, the device does not function.

(4) When registering several A/B rolls with TEMP-R, the result of Q-TRACE may not correct.

(5) When the PORT NAME of GPI is un-set, the information of “un-set” is not saved.

(6) In the A/B roll, immediately after the source of DME, KF, FM, AUX and COLOR is
selected for B roll, the graph may not be displayed.

(7) When the SCROLL FOLLOW EDIT is set to OFF and the scroll is not displayed, if the
number of digit of recorder/source display area is changed, the scroll in the lower side

direction may not work.

(8) The EDL including the split edit in which a note of 64 rows contains cannot be correctly
loaded.

(9) When setting the DMC event to the TO source of A/B roll edit, it cannot be correctly
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executed.

(10) When setting the IN point advance split, the DMC event functions early by the amount of
split.

1.5 Related Technical Memo
* SWEMO05-037 [”Internal Error : Recovery HDD” is displayed on the MENU PANEL.]

Re-installation of recovery data related

* SWEMO05-042R [MFS-2000 System Application Software V2.20]
Version Upgrade to Version 2.20 Related

* SWEMO06-026 [Bug Fix at MFS-2000 System — Panel Application Software Install]

Support when installing on the panel on which the version earlier than V1.10 is running

* SWEMO06-044 [MVS-8000/DVS-9000 System Application Software V6.00/V6.10 (BZS-8050
Plug In Editor V4.00)]
DCU (MKS-8700/2700) V4.13 Related

* SWEMO07-005R [MFS-2000 System Application Software V3.30 (BZS-8050 Plug In Editor
V4.00)]
Version Upgrade of Linux Kernel Related

2. Parts Required for Version Upgrade
2.1 Application Software and FPGA Data
For version upgrade, the following application software and FPGA data are required.

The name and storage location of software are shown below.

Software/Data Name Storage Location
Software for MFS-2000 Switcher Application /Application/SWR
Software for MKS-2470 DME Application /Application/DME
Software for MKS-201X Panel Application /Application/PNL
(Panel)
Software for MKS-201X Menu Application /Application/MENU
(Menu)

MFS-2000 FPGA Data MFS FPGA Data /SWR_FPGA

*  As the software is not an option (merchandise), it has no type name.
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1. Overview of Software
This software, which is made by upgrading the MFS-2000 application software, is named V3.50.
The Editing Control Software BZS-8050 (Plug In Editor), which is contained in V3.50, is upgraded
to V6.00.
To achieve the newly added functions and bug fixes below, all of the software described in this
Technical Memo need to be upgraded.

1.1 New Function
1.1.1 New Function of Switcher

(1) The names of signals selected for key fill and key source are displayed in the Key > M/E Keyl
(M/E Key2, DSK1, DSK2) > Main menu are displayed. [Menu 1000 (1100, 1200, 1300)]

(2) The setting of [Shift Button] is added to the Setup/Diag > Operation > XPT Assign menu.
When the setting of [Shift Mode] is set to ‘Off” , it is valid and *Off” "Hold” "Lock’ can be
selected.

The initial setting is ‘Lock’. And when set to *Off’, the signal selection at the SHIFT side is
inhibited. [Menu 9300]

(3) In case that *Status’ is selected for [Trigger Type] in the Setup/Diag > GPI > DCU GPI Output
menu, 'Device Rec’ is added to [Action].
Since the GPI is outputted in the state that the device is recording, it can be used as a REC
TALLY. [Menu 9405]

(4) The Editor I/F category is added to the Setup/Diag > Maintenance and the setting of [Key Off
Mode] is provided.
‘All Off” or ‘Specified’ can be selected and the initial setting is ‘All Off’.
When receiving the ALL STOP command from the editor, all of the keys become off when set
to ‘All Off” and only the specified key becomes off when set to ’Specified’. [Menu 9702]

1.1.2 New Function of BZS-8050

(1) KEY ... The KEY CUT IN/OUT, KEY MIX IN/OUT, KEY NAM IN/OUT, KEY S-MIX
IN/OUT, KEY WIPE IN/OUT, and KEY FADE IN/OUT can be set to the effect of the main.

(Note) In the P/P, the effect of the KEY cannot be executed.
Moreover, in the M/E, the effects of the KEY3 and KEY4 cannot be executed.

(2) KEY EVENT ... The CUT and AUTO TRANSITION of the transition exclusive for key can
be set by operating in the same manner as GPI irrespective of the effect of the main.

(3) MENU DISP ... The location in the operation menu, background color and font color can be
set in detail.

4) Extended GPI Function ... The functions below have been added.
- The function to set the event time, using the time code of the player
- The function to output the continuous pulses by designating the interval and times
- The function to scroll-display the list of the setup
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(5) BACK AUX ... The setting of the event time of the GPI can be copied to the scratch pad.
To use this function, it is necessary to assign the function to the key with the assign of the

keyboard.

(6) STORE CONST/RECALL CONST ... The special constant registers are provided to all of the
devices.
To use this function, it is necessary to assign the function to the key with the assign of the
keyboard.

(7) RECALL SEGMENT ... The setting of the CCR is added to the target for recall.

(8) DDR VDCP File Load ... Files, which are selected from the displayed list of the disc recorder
(DDR VDCP) can be loaded.
Files used in editing are registered in the EDL and automatically recalled when executed.
Besides, a new file can be created and recorded with the DDR REC function.

(9) 3:2 LOAD ...An EDL created using a material converted to the 30frame can be loaded to the
24frame system and edited with the 2-3 PULLDOWN function.

(Note) It is supported only for REPLACE-CLEAR.
To add an existing EDL, load it in other EDL and then use the MERGE EDL function.

(100A-ROLL RELEASE MODE Setting ...In the A/B roll edit, after the transition is finished, the
A roll is stopped and can be opened.
It is possible to search a scene to be used in the next edit and replace the tape without waiting
the finish of the edit.
INIT > F2: EXECUTION > 8. A-ROLL RELEASE MODE

(1HBVE REEL Setting ... When loading an EDL of the BVE-9100 format, the reel name set to the
DME and color can be converted to the reel name (DM1-DMS, CB1, CB2) exclusive for the
BZE-8050.

When saving an EDL of BVE-9100 format, the reel name exclusive for the BZS-8050 can be
converted to the set name and outputted.

As to the DME, the effect register No. is inherited.

INIT > F6: ASSIGN3 > BVE REEL

(12)DMC RANGE setting ...The speed range of the variable mode and the speed of the SLOW/
SCAN can be set to each device.
When pressing the FF/REW key during DMC editing, the speed becomes the one set to the
FWD/REV.
AUX > F9: DMC RANGE

1.2 Specification Change
1.2.1 Specification Change of Switcher

(1) When [Shift Mode] is set to ‘Off’, the SHIFT button in the AUX bus operating block becomes
high-tally, being liked to the cross-point button.
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1.2.2 Specification Change of BZS-8050

(1) The pop-up display channel at the multi-split setting has been changed from the selection of
either F8: CH1-CH12 or F9: CH13-CH16 to the shift-up as follows.
Every time pressing the F9: REMOTE, the pop-up display channel switches in order of CH1-4
— CH1-8 — CH1-12 — CH1-16 — CH1-4.
The last displayed state is retained when the power is turned off.

(2) Recording a registered edit with being open end was inhibited.
But, this edit can be recorded as a new page only on the condition that the setting of 4.
BACKGROUND REC in NIT > F2 EXECUTION is ‘OFF’ and the setting of 9. QUICK EDIT
in INIT > F3: EDL is ‘ON’.

(Note) In this case, recording does not stop until the REC OFF key or ALL STOP key is
pressed.

(3) The target for superimposing is changed from the fixed EDIT PVW bus to the bus set in 5.
USED PVW BUS of SETUP > F3: SW CTRL.
In case that the setting of 1. START UP in SETUP > F6: SUPER is ‘OFF’ at the start-up, the
superimposition is not performed.
To use superimposing, start up in the state that this setting is ‘ON’.

(4) In case of STOP and STANDBY OFF, the MARK SPEED is inhibited. But, 0% can be set.

(5) The device control is inhibited for 5 seconds immediately after the preview or recording is
interrupted with the ALL STOP.
This time has been shortened.

(6) When recalling and executing an edit which uses DME/KF in AUTO EFFECT DATA = OFF,
the effect of the registered register number is recalled irrespective of presently recalled register
number.

This has been changed so that an identical register number is not recalled.

(7) The device set to the master or sub-master is targeted for the match frame made by the action
track, scroll track, auto track, recorder track and player track.

(8) The action of the device, after recording is terminated by pressing the REC OFF key, is made
same when passing the REC OUT point.

1.3 Limitation
1.3.1 Limitation of IEEE 1394 External Hard Disk Drive

(1) Operation-confirmed model
Use the Maxtor Company or LaCie Company made following models for external hard disk
drive of the MFS-2000.
Do not use models other than these.

0 Maxtor One Touch I1I FireWire 400/USB 2.0 supported model
Model No.
F30A200 (200GB)



T30G300 (300GB)

OMaxtor One Touch III FireWire 800/400/USB 2.0 supported model
Model No.
F30W320 (320GB)
F30W500 (500GB)

OLaCie d2 Quadra Hard Drive eSATA 3Gb/FireWire 800/400/USB 2.0 supported model
Model No.
320GB
500GB
750GB
QOLaCie d2 Quadra Hard Disk eSATA 3Gb/FireWire 800/400/USB 2.0 supported model
Model No.
320GB
500GB
750GB

(2) Initialization Procedure
The purchased hard disk has to be initialized before use.

Execute [Format] in the following procedure, using [Page 4800: Frame Memory > External
HDD > Format].

* Connect the hard disk drive to the switcher and turn on the power.
* The LED lamp on the hard disk drive front blinks for a few seconds.
Do not operate while the LED lamp is blinking.

* Display [Page 4800: Frame Memory > External HDD > Format] and press the [Refresh
Status] button.

At this moment, the error message may appear. Ignore the message and press the [OK]
button.

* Press the [Format] button to execute the initialization of the hard disk drive.
The initialization finishes in a few minutes.

(3) Backup/Restore Operation
When executing the save or read-in of the frame memory image, using [Page 4800: Frame
Memory > External HDD > Backup/Restore], if a large amount of frame memory image is
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targeted, the operation seems to be stopped for a several minutes for preparing the save/read-in

operation.
1.3.2 Other Limitation
(1) Action of M/E Effect Pattern 1031

When operating the system in the 16:9 aspect mode, the H position adjustment value of the
MJE effect pattern 1031 becomes +75.00 at both right and left ends.

1.3.3 BZS-8050 Limitation
When using the effect (key frame) of the switcher, pay attention to the following points.

(1) The region to control with the MFS-2000 is only M/E (M/E1), P/P and MISC (USER1).
The effect of the DME cannot be controlled.



8/19

(2) If a key frame with DME and a key frame without DME exist, depending on the execution
range, the effect may delay or advance halfway.
Therefore, set the DME to key frames, starting with the first one.

(3) When using an effect which creates the animation of the frame memory, the execution delays
by 1 frame with respect to the set edit point.
To avoid this, adjust the edit point beforehand.

(4) Do not set the initial speed when using an effect which creates the animation of the frame
memory.

(5) In case the system manager is connected and the auto scan is being executed, transferring the
register of the switcher takes several 10s seconds (TRANSFERRING FILE is displayed.)

(6) Even if the register data of the switcher is transferred, the register number of the switcher panel
remains unchanged.
To operate the register of the presently displayed number, recall again.

(7) In case of transferring the register data of the switcher, the register name is not inherited.

(8) In case that the MONITORING setting of the SWER CTRL and MIXER CTRL is PVW
(PARA) or PVW (MIX), the signal at the part stopped with the ALL STOP key may be
disturbed.

If you do not overwrite this part, terminate the recording with the REC OFF key.

1.4 Bug Fix

1.4.1 Bug Fix of Switcher
No bug fix is included in this version upgrade.

1.4.2 Bug Fix of DME
No bug fix is included in this version upgrade.

1.4.3 Bug Fix of Panel Menu

(1) When [Shift Mode] is set to ‘Hold’, the tally of the cross-point button of the key fill and key
source selected at the shift side does not light.

(2) In case that the register number of the effect does not match with the display of panel by
starting up the MFS-2000 alone, even if the register number displayed on the panel is recalled,
the key frame cannot be edited.

Therefore, it is necessary to recall the other register number.

(3) In the Variable Length Mode, the VDCP File list may not be correctly taken in.
If a blank is included in the filename, loading fails.

(4) After setting the delay of the device, if Macro is executed, the set value of the START
TC/STOP TC may disappear.

(5) When loading the files of Macro Attach, all of the register numbers may become “1”".
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(6) If Macro Attach is set to the inhibited XPT, a file may not be saved.

(7) If Current Work Register is empty immediately after started up, Macro Attach can not be
deleted.

(8) When executing the Macro, the Original Function of the button, to which Macro Attach is done
with the Macro Only, works.

(9) When setting the AUX Bus Override to the GPI Input Action, if operated quickly, the signal
may not be correctly switched.

1.4.4 Bug Fix of BZS-8050

(1) When the DME WIPE is selected at the switcher side, even if MIX or WIPE is executed, the
DME WIPE, remains unchanged.

(2) Even if the DMC EVEN is set to the BKGD-B with MAN, if the duration of the edit is decided,
it is not executed.

(3) When the next numeral input becomes new input on the scratch pad, if the code key or F/TC
key is pressed before numeral input, it does not become new input.

1.5 Related Technical Memo

* SWEMO05-037 “[Internal Error: Recovery HDD] is displayed on the MENU PANEL”
Re-installation of Recovery Data

* SWEMO05-042R [MFS-2000 System Application Software V2.20]
Version Upgrade to Version 2.20

* SWEMO06-026 [Bug Fix/ Countermeasure against MFS-2000 System — Panel Application
Software Installation]
Support when installing on the panel on which V1.10 and earlier is running

* SWEMO06-044 [MVS-8000/DVS-9000 System Application Software V6.00/V6.10 (BZS-8050
Plug In Editor V4.00)]
DCU (MKS-8700/2700) Software Package of V4.13

* SWEMO07-005R [MFS-2000 System Application Software V3.30 (BZS-8050 Plug In Editor
V4.00)]

Version Upgrade of Linux Kernel

* SWEMO07-025 [MFS-2000 System Application Software V3.40 (BZS-8050 Plug In Editor
V5.01)]
SWR/DME Software Package of V3.40

2. Parts Required for Version Upgrade

2.1 Application Software and FPGA Data
The MFS-2000 system application software and the name and store location of the FPGA data are
as follows.
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1. Software Overview
This Technical Memo describes the version upgrading of the application software of MFS-2000 to
V4.00. The Editing Control Software BZS-8050 (Plug In Editor) that is included in the above
application software is also upgraded to V6.01 at the same time.
All of the software that are described in this Technical Memo should be upgraded to the new
versions in order to realize the new functions as described below.

1.1 New Functions

1.1.1 Switcher-related new functions
(1) New function related to frame memory
* Frame Memory Clip function
The Frame Memory Clip is the function that handles and controls multiple still pictures
as a group of continuing picture. The MFS V4.00 can call the still pictures in the order
of frame sequence and handles them as a moving picture by the use of the Frame
Memory Clip function, without using the key frame function.
Also, moving picture can be recorded as a Frame Memory Clip by selecting the menus;
Menu4600 Frame Memory > Clip Record menu.

|Restricti0ns when using 720P\

- When Clip is recorded, the Clip that consists of even number of Clips is created all the
time. Because the even number of Clips is recorded in all recordings of Clip, the
remaining number of Clip may be 1 Clip or 3 Clips when Clip Pair = ON, or remaining
number of frames may be 1 Clip when Clip Pair = OFF at the end of recording if
recording up to the full capacity is specified. However, this is normal.

- Clip that consists of odd number of Clips cannot be used for any operation. Be sure to use
the Clip that consists of even number of Clips. When Loading or Importing Clips, be sure
to transfer the even number of Clips. In the same way, be sure to delete Clip in units of
two still pictures when deleting still pictures that constitute Clip.

- Continuous call (Animation function) of frame memory using Key Frame can be executed
in units of 2 frames.

- If a snap shot having attribute of Clip Auto Play is called, the top frame of the Clip will not
be played back, but the playback starts from the second frame.

* Creating a pair file and working on it
Either the couple function or the separate function can be used. The couple function is
to combine the two single files consisting of still picture file and frame memory clip to
create a single pair file. The separate function is to separate the pair file into two single
files.

* Freeze and Store mode
Simultaneous Freeze and Store of image became possible. To enable this function,
select the menus; Frame Memory > Freeze menu, and set [Frz&Store] = On.

* Giving arbitrary name when recording image
Giving arbitrary filename when saving image became possible.

* Overwriting image file
Overwriting image file became possible by specifying filename that has already been
saved earlier.
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* Global Rename of image files (Used when converting still images to Clip)
Still images can be converted to a Clip by renaming multiple still picture files globally
using the menus; Frame Memory > File > Rename menu.

* Global Delete of image files
Global deletion of multiple image files became possible by selecting menus; Frame
Memory > File > Delete menu.
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* Calling Frame Memory Clip using snapshot
Frame Memory Clip can be registered as Clip Even in snapshot, and can also be called.
Operator can specify the Auto Play mode that starts playback of Frame Memory Clip as
the same time with snapshot recall.

* Increasing number of Frame Memories that can be saved.
Maximum number of Frame Memories that can be saved is increased. Maximum
numbers of images that can be saved in Frame Memory are shown below.

Numbers
Signal format that can be
saved
4801/59.94 2830
5761/50 2402
10801/50 514
1080i1/59.94 514
1080PsF/23.976 514
1080PsF/24 514
1080PsF/25 514
1080PsF/29.97 514
720P/50 1160
720P/59.94 1160

* Specifying time code at the Start point/Stop point of Frame Memory Clip playback.
The following points can be specified to Frame Memory Clip using the Flexi Pad
Operation Block.

- Specifying the Start point

- Specifying the Stop point

- Specifying the loop playback mode
The above settings can be saved in the snapshot register as an attribute of a snapshot,
can also be called.

* Handling of the TGA file
The Frame Memory Point of the TGA file that is compressed by RLE is supported.

* Calling the Frame Memory Clip-related function using GPI
The Frame Memory Clip-related functions (recording, playback, stop cueing up to the
top of clip) are added to the GPI input actions.

* Frame memory Clip transition
Frame Memory Clip can be played back by interlocking with transition by Mix or Wipe.

|Restriction items and notes|

- The Clip Transition should be executed with the use of the V/K-paired Frame Memory
Clip. At the same time, the Clip Transition should be executed with the Pair mode being
set to ON whereas the Pair mode is located in the Frame Memory > Freeze (or Clip Play,
Clip Record) menu.

- If the Clip Transition is executed as the Auto Transition, the Loop mode is automatically
set to OFF.
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- The Clip Transition setup cannot be saved in the Key Frame. If the Key Frame is
executed, the Clip Transition setup is set to OFF.

- While the Clip Transition is in use, the Pattern Limit cannot be set to ON. Also, when the
Pattern Limit is being set to ON, the Transition Type cannot be changed to the Clip
Transition.

- The transitions that require two-strokes for execution such as the picture-in-picture
pattern and the pre-set color mix in which the stroke mode is set to two-stroke, cannot be
executed normally.

- While the Clip Transition is in use, Start/Stop TC which has been set to Frame Memory
Clip is ignored.

- When Start/Stop of the Background Transition has been set, a part of the Wipe pattern (a
part of Karaoke and Rotary Wipe) will not be cut-out but remains un-cut on the screen.
Do not use the following patterns, or do not set Start/Stop for the following patterns:

Karaoke#220, 221, 222, 223

Rotary Wipe#101, 103, 104, 105, 106, 107, 150, 156, 158, 160, 162, 518, 604, 624 and
661

Mosaic #1701

Defocus #1702

- The HIGH tally turns ON until the end of a transition once a Clip Transition is started
even when the background picture of A/B bus is not output.

- When the Clip Transitions that use the same frame memory output, are executed from the
multiple M/E rows at the same time, the Clip Transitions do not work normally.

- The Auto Transition operation and the Clip Transition operation using the Fader are
different when the Advanced Tally Mode has been set. At the same time, the background
transition delays but the Clip does not delay when the Advanced Tally Mode has been set.

- The status while the Clip Transition is under execution cannot be memorized in the snap
shot. When the snap shot is called, the Clip position cannot be reproduced, but system
goes to the top always.

- If a snap shot containing Clip Transition is called while the Clip Transition is under
execution, the transition immediately after the call does not work normally. Be sure to
call snap shot after Transition is completed.

- If the snap shot containing the Clip Transition with EFF DISSOLVE is called
consecutively, the Background Transition may shifts sometimes.

- When snap shots of multiple regions having the same register number are called, the clip
that has the higher order of priority in (P/P>M/E-1>2>3>User) is called. However, if the
snap shots having different register numbers depending on shot box are specified and
called, the order of priority is ignored.

- When calling the Clip Recall and Play consecutively in Macro, it is requested to insert the
Pause even of more than 5 frames between the Clip Recall and Play.

(2) FM Data Port
When the FM Data Port is enabled, the time required for transferring the frame memory data
between switcher and control panel can be shortened.
When using the FM Data Port, select the menus: Menu9102 Setup/Diag > System > System
Adjust menu and set [FM Data Port] to Enable.
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|Restricti0n items and notes|

- Simultaneous data transfer from multiple clients (menus or System Manager) to the FM
Data Port of a switcher is not possible. If the simultaneous data transfer is attempted, an
error will occur and data will not be transferred normally.

- If multiple numbers of the clients (control panel or System Manager) exist from which data
transfer is going to be made, set [FM Data Port] to Enable at an single client only, and set
[FM Data Port] of other clients to Disable.

1.1.2 DME new functions
(1) An effect pattern is added.

Effect number Group name
1232 Frame IN/OUT
This is the effect pattern that enables operator to let the preset image appear with Mix and

disappear with Mix.
The zoom ratio, rotation, position and perspective for the new function can also be adjusted.
Example:

* )

A A B A

Fader position:

The pattern appears Fader position:
Start point (0%) P PP P

with MIX effect. End point (100%)

1.1.3 Panel new functions
(1) Calling Macro by the GPI input
Macro can be called by the GPI input.

(2) Addition of the Macro Only Mode setup function
A mode is added in which Macro attachment can be performed in the Macro Only Mode by
pressing the [PRE MCRO] button and the [POST MCRO)] button at the same time.

(3) Addition of Macro events

The following items are added to the Macro events.
- Calling the Frame Memory Clip (ClipLoad)
- Recording into VTR/Disc recorder (Device Record)
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4. Mode selector button of the Flexi-Pad Operation Block
- Assignment of the [DEV CTRL (device control)] became possible. When [DEV CTRL
(device control)] is selected, the following operations are enabled.
Play, Stop, All Stop, Cue Up, Start TC, Shuttle, Jog, Rec, FM Loop and Stop TC
- An operation mode that is dedicated transition of the M/E key is added to the Flexi-Pad
Operation Block. Another new function is added that enables operator to switch the
Flexi-Pad Operation Block to the dedicated transition operation mode of the M/E key.
- The following operations can be performed from the Utilities Operation Block.
= FM1 K Clip to FM3 K Clip
= FM1 Clip to FM3 Clip
= FM Loop setting (FM Loop)
= Stop TC setting of Clip (Stop TC)
The Mode selector button of the Flexi-Pad Operation Block can be assigned to the Utilities
Operation Block.

1.1.4 Menu new function
(1) DME status window pop-up
- While the [EFF] button of the Transition Operation Block or of the Flexi-Pad Operation
Block is being pressed down, the following window pop-up is displayed showing status of
DME.
Example:

B} D\VE Status

ransition ich Effect 2ch Effect
M/E Trans
M/E Key1 Trans
ME Key2 Trang, | —

Cloze
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1.1.5 New functions that are added to BZS-8050

FM CLIP Control - - - A Clip can be selected from the Clip List display of the frame memory, can
be loaded and be controlled in the same way as VTR. The Clip that is used
for editing is registered in EDL and is called automatically during execution.
In addition to it, a new Clip can be created and memorized with the use of
the CLIP REC function.

Note: If frame memory is operation from the switcher side while recording of a new clip is in

progress, the new clip may not be recorded normally.

1.2 Specification Changes

1.2.1 Switcher-related specification changes
(1) Operability of the Show Key is improved

When operator wants to execute the Show Key from other key while [Show Key] = ON is
set by using the menus; Menulx00 (x =0 to 3) Top > Key > M/E (P/P) Keyl (Key2, DSK1,
2) menu, the conventional software requests operator to set the [Show Key] under execution
to OFF once, and the operation to set [Show Key] = ON for the new key. From this new
version, the software is improved so that the Show Key under execution is automatically
turned OFF when [Show Key] = ON for the new key is set.
When operator wants to execute the Show Key with the new key, set [Show Key] = ON
once again. (It means that the Show Key under execution is turned OFF by the first operation,
and the Show Key for the new key is executed by the second operation. Priority is given the
operation that is executed later.)

(2) Display on the Flexi-Pad Operation Block when the DME pattern number that does not exist
is pressed.
(2) If a DME pattern number that does not exist is pressed, the specified DME pattern number
that does not exist has been displayed on the Flexi-Pad Operation Block in the conventional
software. However, it is improved so that the DME pattern number before the DME pattern
number is specified, is displayed on the Flexi-Pad Operation Block in the new version.

(3) The desired interpolation processing method can be selected for each input of video and key
when the signal format is either 5761 or 4801i. (Field Mode is added.) The desired
interpolation processing method can be selected in the following menus:

* Menul406 Key>M/E K1 Trans > Interpolation
= Menul506 Key > M/E K2 Trans > Interpolation
= Menu2008 Effect/Wipe > M/E Effect > Interpolation

1.2.2 DME-related specification changes
(1) Corner processing of beveled edge is improved
In the conventional software, the edge width is set with the fixed aspect ration of 4:3 (16:9).1t is
improved so that corner processing of the beveled edge can be set with equal width at all of the
four edges. To enable this function, set the menus; Menu9304 Setup/Diag > Operation >
Transition menu, and set [Bvl Edge Wid] = [Even].
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1.2.3 Panel-related specification change
Not included in this version upgrade.

1.2.4 Menu-related specification changes
(1) Show Key Always On
A mode is newly added that does not terminate the monochrome Key signal that is key-
processed from the Edit PVW output even after elapse of certain time. To enable this function,
select the menus; Menu9303 Setup/Diag > Operation > Key menu, and set the [Show Key] to
“Always On”.

(2) Menu4300 Frame Memory menu
(2-1) The following indications are added to enable operator to understand which of the Video
key is being operated.
*FM 1to3
* Video/Key
= Pair On/Off
(2-2) Change of Pair ON to Pair OFF by the calling from snapshot or Key Frame is reflected in
real time.

(3) Filenames that are prohibited of use
The following filenames cannot be used in the FAT file system.
CON, PRN, AUX, CLOCKS, NUL, COM0, COM1, COM2, COM3, COM4, COMS, COM6,
COM7, COMS, COM9, LPTO, LPT1, LPT2, LPT3, LPT4, LPTS, LPT6, LPT7, LPT8 and LPT9.

1.2.5 Specification changes of BZS-8050
Not included in this version upgrade.

1.3 Restrictions
1.3.1 Restriction on the IEEE 1394 external hard disk

(1) Hard disk models with which operations have already been verified:
Use the following models of Maxtor or LaCie as the external hard disk drive of MFS-2000.
Do not use the hard disk other than the following models.

** Hard disk models of Maxtor OneTouch III Fire Wire 400 / USB 2.0 supported model
Model numbers
F30A200 (200GB)
T30G300 (300GB)
** Hard disk models of Maxtor OneTouch III Fire Wire 800 / 400 / USB 2.0 supported model
Model numbers
F30W320 (320GB)
F30W500 (500GB)
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** Hard disk models of LaCie d2 Quadra Hard Drive eSATA 3Gb/FireWire 800/400/USB 2.0
supported model
Model numbers
320GB
500GB
750GB
** Hard disk models of LaCie d2 Quadra Hard Disk eSATA 3Gb/FireWire 800/400/USB 2.0
supported model
Model numbers
320GB
500GB
750GB

NEVER turn OFF the power nor disconnect any cable of the hard disk while the power to
the system is turned ON.

(2) Initialization procedure
The purchased external hard disk drive needs to be initialized before using.
Use the menus [Page 4800: Frame Memory > External HDD > Format] and execute [Format]
by following the steps described below.

** Connect the hard disk drive to the switcher and turn the power ON.

** The LED lamp on the front of the hard disk drive flashes for several seconds. Do not
perform any operation while the LED lamp is flashing.
Select the menus in this order: [Page 4800: Frame Memory > External HDD > Format].
Press the [Refresh Status] button.

An error message may be displayed sometime but you can ignore it and press the [OK]
button.

** Press the [Format] button to start initialization of the hard disk drive.

Initialization will complete in several minutes.

(3) Backup/Restore operation
When the menus [Page 4800: Frame Memory > External HDD > Backup/Restore] is selected
to execute saving or reading of frame memory image, the machine looks as if it stops for
several minutes that are required for preparation of the save/read operations if a large amount
of frame memory images are going to be handled.

1.3.2 Other Restrictions

(1) Operation of the M/E effect pattern 1031
The H-position adjustment value comes to the position within the range of £75.00 from both
ends of right-most end and the left-most end of the M/E effect pattern when running the system
in the 16:9 aspect mode.

1.3.3 Restrictions on BZS-8050
When using an effect (key frame) of a switcher, pay attention to the followings
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(1) The regions that can be controlled by the MFS-2000 are only M/E (M/E1) and P/P and MISC
(USERI). At the same time, it cannot control the DME effect.

(2) When two types of key frames are mixed whereas DME has been set to one type of key frame
while DME has not been set to the other type, there can be a case that the effect can lag or lead
in the midst of the effect. To prevent this trouble, set DME from the very first key frame.

(3) If an effect in which animation of frame memory data has been created is used, execution of
the effect delays after the set editing point by one frame. To prevent this trouble, adjust the
editing point beforehand.

(4) When using the effect that is used to create animation of frame memory, do not set the initial
speed.

(5) When the AUTO SCAN is in progress while the system is connected to a system manager,
there can be cases that several 10 seconds are required to transfer the register data of the
switcher. (The message TRANSFERRING FILE is displayed.)

(6) The register numbers of the switcher panel remain unchanged even when the register data of a
switcher is transferred.
In order to operate the register of the number being displayed, repeat the RECALL operation
again.

(7) When register data of a switcher is transferred, the register name will not be inherited.

1.4 Bug fix
1.4.1 Bug fix of Switcher
(1) The M/E Key PVW output level and the DKS PVW output level are different.

(2) When the "FM V Freeze Off” is set, or when the ”FM K Freeze Off” is set at the SWR GPI
Input, the Frame Memory menu remains unchanged in Freeze = ON, and the setting is not
reflected.

(3) When the transition type is changed from [EFF] to [MIX] at the local side, and when the DME
Wipe transition is executed by the common side, the system enters Cut sometimes.

(4) When the effect file and the wipe snapshot file are called one after another, and are executed,
the A-bus picture and the B-bus picture are exchanged sometimes.

(5) When the bus toggle is set to OFF, and when the non-sync fader is executed, the Key ON tally
illuminates sometimes.
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1.4.2 Bug fix of DME
(1) When P-in-P of DME Wipe is selected, and when position of the Position V is changed from
minus (-) position to 0, the Trail effect disappears.

1.4.3 Bug fix of Panel Menu
(1) When the menus are selected as follows: Menulx00 (x = 0 to 3) Top > Key > M/E (P/P) Key1
(Key2, DSK1,2) menu, and when the [Key Source] = “Split” is selected, and at the same time,
when the cross-point video side is selected as key source, the display does not follow so that
name of the sources as described above are not displayed on the menu.

(2) When the M/E transition rate is set from the Flexi-Pad Operation Block, and when auto
transition is executed, the M/E setup value is reflected to P/P.

(3) When any number that is prohibited to enter is entered in the PTN No. entry mode of the key
transition operation mode of the Flexi-Pad Operation Block, the number is not accepted so that
the pattern immediately before remains actually. However, the entered number is displayed on
the LCD display block of the Flexi-Pad Operation Block.

(4) If two or more of [START TC] are assigned to the Device/Utility button, multiple number of
buttons do not illuminate, and only one button illuminates.

(5) When a value is entered in Variable or knob is operated to select a value, and when [Variable
Set] is pressed in the [TC Status] menu that is selected by Page5600 Misc > DDR/VTR >
Timecode Status menu, the value becomes always 0%.

(6) The cross-point data is output to the destination numbers 139 and 140 that are outside of the S-
Bus switcher matrix range (136 x 138).

1.4.4 Bug fix of BZS-8050
The following troubles of BZS-8050 V6.00 are corrected in BZS-8050 V6.01.

(1) When recording is stopped by ALL STOP, the recorded signal of the stopped point loses
synchronization sometimes.

(2) When an edit that sets recorder as the source is selected as the target of AUTO TRACK or
RECORDER TRACK, the calculated time code data becomes erroneous.

(3) When the first edit is executed, the DF/NDF setting of the INIT > SYSTEM is not reflected
correctly sometimes.
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